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Enhancing the Usage of Libre Office Impress Tool for Teaching Science 

Among Upper Primary Teachers through Hands on Practice 

 

1.0. Introduction 

In the present digital age, integrating technology into education is essential to make 

learning engaging and effective. Among various digital tools, presentation software like 

LibreOffice Impress plays a significant role in teaching science by making concepts 

visually appealing and interactive. However, many upper primary teachers lack 

adequate training and confidence to use these tools effectively. This research focuses 

on enhancing the usage of LibreOffice Impress for teaching science among upper 

primary teachers through systematic hands-on practice. 

1.1. Libre Office -Introduction  

LibreOffice is a powerful and free office suite, used by millions of people around the 

world. LibreOffice is a successor to OpenOffice.org (commonly known as OpenOffice), 

which in turn was based on Star Office. Its clean interface and feature-rich tools help 

you unleash your creativity and enhance your productivity. LibreOffice includes several 

applications that make it the most versatile Free and Open Source office suite on the 

market: Writer (word processing), Calc (spreadsheets), Impress (presentations), Draw 

(vector graphics and flowcharts), Base (databases), and Math (formula editing). 

LibreOffice is compatible with a wide range of document formats such as Microsoft® 

Word (.doc, .docx), Excel (.xls, .xlsx), PowerPoint (.ppt, .pptx) and Publisher. But 

LibreOffice goes much further with its native support for a modern and open standard, 

the Open Document Format (ODF). With LibreOffice, you have maximum control over 

your data and content – and you can export your work in many different formats 

including PDF. 

1.1.1. Advantages of LibreOffice 

• No licensing fees. LibreOffice is free for anyone to use and distribute at no cost. 

Many 

• features that are available as extra cost add-ins in other office suites (like PDF 

export) are free with LibreOffice. There are no hidden charges now or in the 

future. 
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• Open source. You can distribute, copy, and modify the software as much as you 

wish, in accordance with the LibreOffice Open Source licenses. 

• Cross-platform. LibreOffice runs on several hardware architectures and under 

multiple operating systems, such as Microsoft Windows, Mac OS X and Linux. 

• Extensive language support. The LibreOffice user interface, including spelling, 

hyphenation, and thesaurus dictionaries, is available in over 100 languages and 

dialects. 

• LibreOffice also provides support for both Complex Text Layout (CTL) and 

Right to Left (RTL) layout languages (such as Urdu, Hebrew, and Arabic). 

• Consistent user interface. All the components have a similar “look and feel,” 

making the measy to use and master. 

• Integration. The components of LibreOffice are well integrated with one 

another. All the components share a common spelling checker and other tools, 

which are used consistently across the suite. For example, the drawing tools 

available in Writer are also 

• found in Calc, with similar but enhanced versions in Impress and Draw. Do not 

need to know which application was used to create a particular file. For example, 

we can open a Draw file from Writer. 

• Granularity. Usually, if you change an option, it affects all components. 

However, LibreOffice options can be set at a component level or even at 

document level. 

• File compatibility. In addition to its native OpenDocument formats, LibreOffice 

includes support for opening and saving files in many common formats including 

Microsoft Office, HTML, XML, WordPerfect, Lotus 1-2-3, and PDF. 

• No vendor lock-in. LibreOffice uses OpenDocument, an XML (extensible 

Mark-up Language) file format developed as an industry standard by OASIS 

(Organization for the Advancement of Structured Information Standards). These 

files can easily be unzipped and read by any text editor, and their framework is 

open and published. 
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• have a voice. Enhancements, software fixes, and release dates are community 

driven. 

1.1.2. Parts of the main window 

The main window is similar for each component of LibreOffice, although some details 

vary. See the relevant chapters in this guide about Writer, Calc, Draw, and Impress for 

descriptions of those details. Common features include the Menu bar, standard toolbar, 

and formatting toolbar at the top of the window and the status bar at the bottom. 

1.1.2.1. Menu bar 

The Menu bar is located across the top of the LibreOffice window, just below the title 

bar. When we select one of the menus listed below, a sub-menu drops down to show 

commands. 

• File – contains commands that apply to the entire document such as Open, Save, 

and Export as PDF. 

• Edit – contains commands for editing the document such as Undo, Find & 

Replace, Cut, Copy, and Paste. 

• View – contains commands for controlling the display of the document such as 

Zoom and Web Layout. 

• Insert – contains commands for inserting elements into your document such as 

Header, Footer, and Picture. 

• Format – contains commands, such as Styles and Formatting and AutoCorrect, 

for formatting the layout of your document. 

• Table – contains commands to insert and edit a table in a text document. 

• Tools – contains functions such as Spelling and Grammar, Customize, and 

Options. 

• Window – contains commands for the display window. 

• Help – contains links to the LibreOffice Help file, What’s This, and 

information about the program. 

1.1.2.2. Toolbars 

LibreOffice has two types of toolbars: docked (fixed in place) and floating.  

Docked toolbars can be moved to different locations or made to float, and floating 

toolbars can be docked. 
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In a default LibreOffice installation, the top docked toolbar, just under the Menu bar, is 

called the Standard toolbar. It is consistent across the LibreOffice applications. 

The second toolbar at the top, in a default LibreOffice installation, is the Formatting 

bar. It is context-sensitive; that is, it shows the tools relevant to the current position of 

the cursor or the object selected. For example, when the cursor is on a graphic, the 

Formatting bar provides tools for formatting graphics; when the cursor is in text, the 

tools are for formatting text. 

2.Identification of the problem 

Upper primary science teachers are said in their feedback of one day ICT training was 

not adequate time to be given to make better use of Libre office Impress Tool and 

develop new skills. In ICT training, an hour is very little to learn about Libre office 

Impress and practice them on a computer. Based on the training observation the 

practitioner felt that need one more day of training to build capacity. 

Based on the school classroom observation during school visits the practitioner felt that 

teachers are not properly teach ICT lesson (Libre Office Impress-Chapter -25) due to 

lack of knowledge in the Tool. Through this action research the inputs given in the 

training through hands on practices can be enhanced the usage of libre impress tool in 

science teaching among the upper primary science teachers. 

3.Need of the Action Research 

Teacher must change their role in the technologically driven education to meet the 

requirement of teaching. Using ICT tools will be an effective tool for developing 

understanding and skill to use different applications. The focus of the action research 

was on the processes of learning, about ICT tools and its applications. Developing ICT 

skills among teachers enabled them to plan and implement ICT integrated learning 

experiences and creating learning environment for students. 

Tamil Nadu Government school Education department has started to develop Hi-Tech 

laboratories in all the Government Higher secondary and High schools by providing 

software, Hardware and requires infrastructural facilities under different schemes. 
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Many practices have already been started in the form of innovation by schools and 

different educational organizations in our state. But still there is lacuna in utilization of 

ICT laboratory facilities and provided educational software and apps by the teachers 

and students. Moreover, teachers are not aware of such educational application of 

technology, apps, games etc. It is highly essential that today’s teachers are techno smart 

to deal with the learners’ expectation.  

Observations during classroom monitoring and interactions with teachers revealed 

that: 

• Most upper primary teachers were using traditional chalk-and-talk methods. 

• Many teachers lacked familiarity with LibreOffice Impress, despite having 

access to computers. 

• Teachers expressed interest but faced challenges in designing presentations that 

explain science concepts effectively. 

This led to the initiation of this action research to improve their skills and boost 

confidence through hands-on training sessions. 

Based on this background information, the practitioner felt that this kind of action 

research is necessary to Enhancing the usage of Libre office Impress Tool in science 

teaching among Upper Primary Science Teachers. 

4.Statement of the Problem 

Libre Impress provides all the common multimedia presentation tools, such as special 

effects, animation, and drawing tools. It is integrated with the advanced graphics 

capabilities of Libre Office Draw and Math components. Sideshows can be further 

enhanced using Font work special effects text, as well as sound and video clips. Impress 

is compatible with Microsoft Power Point file format and can also save your work in 

numerous graphics formats, including Macro media Flash (SWF). If communication 

technologies are to be used effectively, teachers must be provided with computers easily 

and adequately and properly trained to operate teachers. So, the statement of the action 
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research is Enhancing the Usage of Libre office Impress Tool in science teaching 

Among Upper Primary Teachers. 

5.Objectives of the Action Research 

1. To enhance the usage of Libre office Impress Tool in science teaching through 

hands on training. 

2. To make the science teachers to teach Libre office Impress Tool in classroom 

transactions. 

3. To train the teachers to create slides using Libre office Impress 

6.Probable causes for the problem 

1. ICT training has been provided to graduate teachers, but they are not practicing 

what they have learnt in the training immediately. 

2. Not adequate knowledge to teach this Tool 

3. Lack of time to practice this Tool 

4. Lack of interest and motivation to use ICT 

5. Non-availability of ICT facilities in their schools,  

6. Insufficient time for preparation. The practitioner considered these factors may 

be the probable causes for the problem. 

7. Hypothesis  

After the intervention, the usage of Libre impress tool will be enhanced in science 

teaching among upper primary teachers. 

8. Interventions 

• Orientation sessions for teachers on the features and benefits of LibreOffice 

Impress. 

• Development and distribution of comprehensive training modules. 

• Hands-on workshops focused on creating science presentations using 

LibreOffice Impress. 

• Encouraging teachers to design lesson-based presentations incorporating 

multimedia elements. 
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9.Methodology 

a. Sample:  16 Upper primary school science teachers from Dharmapuri block were 

taken as sample for the action research. 

b. Design: Pre-test, Intervention, Post-test method was followed as the research design for 

the action research.  

c. Action research Tool 

Questionnaire was prepared by the practitioner to know pre-knowledge of libre impress 

tool and the usage in science classroom teaching and it is used as tool for this action 

research. The same questionnaire was used for post-test. The tool was attached in 

appendices (Annexure-1).  

d. Procedure of data collection 

WhatsApp group was created for the purpose of this action research and all the teachers 

joined in the group. Purpose of action research were explained to them through the 

group. The google form link for pre-test tool was shared in the group and the data were 

collected. The procedure to fill the questionnaire was also instructed. The post-test 

questionnaire was given to the teachers at the end of the one-day training session and 

the post test data was collected. 

(e) Intervention 

• Orientation sessions for teachers on the features and benefits of LibreOffice 

Impress. 

• Development and distribution of comprehensive training modules. 

• Hands-on workshops focused on creating science presentations using 

LibreOffice Impress. 

• Encouraging teachers to design lesson-based presentations incorporating 

multimedia elements. 

A module was developed by the practitioner briefly explaining the Libre impress tool. 

The module was distributed to all teachers. Details regarding Libre Office -Introduction, 

definition, Applications of LibreOffice, presentation, create a Blank Presentation, 
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working in a Slide, Inserting New Slide, inserting pictures, inserting text box, inserting 

audio and video files, Slide transition, animation, Deleting Slide, saving a Presentation, 

viewing a Slide Show, closing a presentation, opening an Existing Presentation and Exit 

LibreOffice Impress were explained in the module. One day orientation hands-on 

training was given to the science teachers in the Hi-tech lab. Majority of the teachers 

used laptop for creating the slides. After creating slides, they were used as TLM for 

science teaching learning process. All the teachers are asked to choose one science 

lesson and create the slide, then created slides was shared in the WhatsApp group to use 

these slides during science teaching. (Training module was attached in Annexure-2) 

Slides was prepared through Libre office Impress for science classroom teaching. 
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(iv). Data analysis 

After conducting pre-test and post-test, the scores were tabulated and converted to 100 

marks. The data were analysed based on 

1.A comparison of pre-test and post-test scores. 

2.A comparison of average scores of pre and post test scores 

10. Analysis and Interpretation 

The data were analysed based on the comparison of pre-test and post-test scores as well 

as the average scores of pre and post-test. A Pre-test was administered to a sample of 

16 BT Science teachers. After the intervention post-test was conducted to the same 

group of teachers. The results were compared with the pre-test scores and analysed 

accordingly. The scores of both Pretest and Post-test were tabulated and converted to 

100 marks. 

(i) Comparison of pre-test and post-test scores 

The result was analysed based on the comparison of pre-test and post-test scores of 

teachers, which are given in the following table and charts. 

 

Table-3: Showing Science Teacher’s pre and post test scores 

 

Sl. 

No 
Name of the science teacher 

 

Pre-test scores Post -test scores 

1 Sample-1 25 75 

2 Sample-2 36 79 

3 Sample-3 26 84 
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Sl. 

No 
Name of the science teacher 

 

Pre-test scores Post -test scores 

4 Sample-4 40 82 

5 Sample-5 38 75 

6 Sample-6 28 76 

7 Sample-7 34 90 

8 Sample-8 32 85 

9 Sample-9 20 86 

10 Sample-10 24 78 

11 Sample-11 26 92 

12 Sample-12 35 84 

13 Sample-13 37 86 

14 Sample-14 29 82 

15 Sample-15 28 80 

16 Sample-16 30 88 

  617 1646 

 

Chart-1: Comparison of Pre-Test and Post Test scores 
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The results revealed that the scores obtained by the science teachers in the post-test 

were higher than the pre-test scores. From the results it was observed that the 

intervention activities have brought positive influence in enhancing the usage of libre 

impress in science teaching among science teachers. 

 

ii.) Comparison of average scores in pre-test and post-test scores 

The results were analysed based on the comparison of average scores of pre and post-

test of science teachers. Which are given in the following table and charts. 

 

Table-2: Showing Science Teacher’s Average scores in pre and post -test  

 

Number of 

Science 

Teachers 

Average scores 

 in pre -test  

Average scores 

 in post -test  

Difference in pre and 

post-tests scores 

16 31 83 52 

 

 

Chart 2: Comparison of Average Scores of Pre-tests and Post-Test 
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The average score of the pre-test was 31 % and the average score of the post-test was 

83 %. This result given a clear picture that the post-test scores were 52 % higher than 

the pre-test scores. 

The average percentage of gain scores which was 52 % higher than the pre- test average 

scores. It was showed that the intervention strategies adopted by the practitioner had 

brought out desirable changes in usage of libre impress tool among teachers. 

 

11.Findings of the Action Research 

1. Teachers who undergone hands-on training showed higher confidence in using 

Impress. 

2. Visual presentations were effective in simplifying complex science concepts. 

3. Peer-learning and group activities promoted collaborative learning among 

participants. 

4. Students responded positively to the visual presentations and exhibiting 

improved concept retention. 

Net gain of the Action Research  

Improved Teaching Efficiency  

• Teachers will be able to create dynamic, visually appealing, and interactive 

presentations to explain scientific concepts more effectively.  

• Reduces time spent on traditional blackboard explanations and allows better use 

of classroom time for discussions and demonstrations.  

Better Student Engagement  

• Visually rich slides, animations, and interactive diagrams help in capturing student   

attention.  

• Complex topics (like life processes, energy conversion, etc.) can be explained 

through simulations and step-by-step visual flowcharts. 
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Enhanced Conceptual Understanding  

• The use of visuals and animations in LibreOffice Impress simplifies abstract 

science concepts, aiding deeper understanding. 

 • Teachers can incorporate multimedia elements (images, videos, hyperlinks) to 

create a multi-sensory learning experience. 

Development of Teachers' ICT Competency 

 • Hands-on training boosts teachers’ confidence in using ICT tools for daily 

teaching. 

 • Encourages the habit of preparing digital teaching resources, aligning with NEP 

recommendations.  

Resource Sharing and Collaboration  

• Teachers can develop a repository of digital teaching materials that can be shared 

among peers.  

• Promotes collaborative planning and reduces duplication of effort in content 

preparation.  

Cost-Effective and Open-Source Advantage  

• LibreOffice Impress is free and open-source, eliminating licensing costs.  

• It can be easily installed on school computers or teachers' personal devices without 

financial constraints.  

Scalability and Sustainability  

• Once teachers are trained, they can further mentor other teachers, creating a 

sustainable model for ICT integration.  
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• The resources developed can be modified and updated for future use without 

dependency on external agencies.  

Contribution to Digital Education Initiatives 

 • Aligns with national and state-level digital education programs, promoting digital 

literacy among educators.  

• Prepares teachers for blended learning and online teaching scenarios, if needed. 

Termination of Action Research  

The present action research aimed at enhancing the usage of the LibreOffice Impress 

tool among upper primary science teachers through structured hands-on practice 

sessions. The research process involved identifying the gaps in digital presentation 

skills, planning and conducting targeted training workshops, providing continuous 

support, and assessing the improvement in teachers' confidence and skills in using 

LibreOffice Impress for science teaching.  

Throughout the intervention, teachers demonstrated noticeable growth in their ability to 

design effective, visually appealing, and content-rich presentations tailored to science 

lessons. The hands-on approach, combined with regular feedback and peer sharing, 

proved instrumental in improving both skill and interest levels. Teachers reported 

greater confidence in incorporating digital tools into their pedagogy, thereby making 

science lessons more engaging and interactive for students.  

The results of this research indicate that with the right guidance, practice, and 

encouragement, teachers can quickly adapt to using open-source digital tools like 

LibreOffice Impress in classroom teaching. This not only supports cost-effective digital 

learning solutions but also promotes self-sufficiency and innovation among educators.  

The action research is hereby concluded with the satisfaction that the objectives were 

successfully achieved. Further efforts can be taken by educational institutions and 
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training institutes to scale up similar programs and integrate them into regular teacher 

professional development modules. 

Recommendations and Educational Implication 

Recommendations 

Organize Regular Hands-On Training Workshops 

• Conduct regular, short-term and long-term workshops focused on creating 

science presentations using LibreOffice Impress. 

• Include real-world examples and classroom scenarios to help teachers relate to 

practical teaching needs. 

Develop a Step-by-Step Instructional Manual 

Create a simple, illustrated guide and video tutorials demonstrating key features like 

slide creation, embedding images, animations, hyperlinks, and using templates for 

science lessons. 

Form Peer Learning Groups 

Encourage the formation of teacher communities to share tips, presentation samples, 

and best practices, enabling continuous collaborative learning. 

Incorporate Project-Based Tasks 

Assign teachers with classroom-based science presentation projects, reviewed by peers, 

to promote active usage and creativity in designing lessons. 

Use Multilingual Resources 

Provide training material and tutorials in local languages in addition to English, making 

the tool more accessible and less intimidating. 
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Promote Open-Source Awareness 

Highlight the cost-effectiveness, flexibility, and freedom offered by LibreOffice 

Impress as an open-source tool, reducing dependency on paid software. 

Periodic Evaluation and Feedback 

Conduct evaluations after each training session and gather feedback from teachers to 

identify challenges and modify training approaches accordingly. 

Educational Implications 

Enhanced Visual Learning 

Teachers equipped with Impress skills can integrate more visual aids, interactive 

diagrams, and animations into science lessons, making abstract concepts more concrete. 

Improved Student Engagement 

Well-designed science presentations can foster curiosity, sustain attention, and help 

students understand scientific processes better through visual storytelling. 

Encouragement of Digital Literacy 

Teachers mastering Impress will contribute to building a digitally literate environment, 

where students too can learn to present their ideas effectively. 

Development of Critical Thinking and Creativity 

The process of designing presentations encourages teachers (and later students) to think 

critically about content structure and delivery, fostering innovation in science 

communication. 
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Equitable Access to Educational Technology 

Promoting free tools like LibreOffice Impress helps bridge the technology gap in 

resource-limited schools, ensuring all teachers and students benefit from digital tools. 

Sustainable ICT Integration in Education 

By making teachers confident in using open-source presentation software, schools can 

sustainably integrate ICT in education without financial strain. 

12.Conclusion 

The integration of LibreOffice Impress as a teaching tool has proven to be an effective 

strategy in empowering upper primary science teachers with modern presentation skills. 

Through hands-on practice sessions, teachers gained practical knowledge and 

confidence in designing interactive and visually engaging science lessons. This not only 

enhanced their ability to present complex scientific concepts in a simplified and 

structured manner but also fostered greater student engagement and understanding. The 

initiative demonstrated that with proper training and consistent practice, digital tools 

like LibreOffice Impress can significantly enrich classroom teaching. Moving forward, 

continued support, refresher training, and the sharing of best practices will be essential 

to sustaining and expanding the positive impact of this program in science education. 

 

13. Bibliography 

• Government of Tamil Nadu, Tamil Nadu Textbook and Educational Services 

Corporation, Standard Nine Science book (2024 Edition) 

• LibreOffice Official Documentation 

• NCERT ICT Curriculum for Teachers 

• Research articles on Technology Integration in Education 

  



18 
 

14.Action research tool 

District Institute of Education and Training Settikarai-636704, Dharmapuri 

District 

 

Action Research Tool-2024-2025 

                                                                             

Name of the Practitioner 

DR.K. KANNIAMMAL 

Lecturer, DIET 

Settikarai - 636704 

Dharmapuri District 

 

Title: Enhancing the Usage of Libre Office Impress Tool for    Teaching Science 

Among Upper Primary Teachers through Hands on Practice 

 

Questionnaire for Science Teachers 

Name (Block letters):  

Name of the School: 

Gender: 

 

I. Choose the correct answer.       (6x1=6) 

1. _______________ is a structured delivery of information.  

a. Slide Show     b. Page  

c. WordArt     d. Presentation  

2. The slides are grouped together in a sequence to form _________________  

a. slide show     b. sorts  

c. page      d. messages  

3. A presentation consists of many _________  

a. pages      b. slides  

c. placeholders    d. messages  
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4. which key should be pressed to run a slide show?  

a. F1   b. Tab   c. F5    d. F2 

 

5. _______________ is used to insert attractive text in the slide.  

a. Slide Show     b. Word Art  

c. Text      d. Header and Footer  

 

6. Image option is present under the ............................. menu.  

a. Format      b. Insert    

c. Tools      view 

 

II. Answer briefly.        (5x2=10) 

1. Write steps to change the slide background.  

 

2. Write steps to insert an image in your slide. 

 

3. Identify the following icons of content placeholder  
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4. Name the components of slide 

 

 

 

 5. As a teacher, how can you integrate libre impress tool in Science  

    teaching?  

 

 

 

 

III. Lab Work         (1x4=4) 

1. Create a presentation on any science lesson. Save it with suitable name.  
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15. Photos 

 

 

 

Practitioner Explains about Libre impress tool 
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Mr. S.K. Saravanan, Senior Lecturer demonstrated ICT tools 

 

Dr. B Silambarasi, Senior Lecturer explains about the usage of libre impress tool  

 

 

Dr.K.Kanniammal, Lecturer guided teachers to prepare slides using libre impress  
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Module was distributed to the teachers 

 

Teacher has used slides in classroom transactions 
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Training module on Libre Office Impress 

 

1.0. Learning Objectives  

After the completion of this module, teachers will be able to:  

• define presentation.  

• create a new presentation.  

• insert text box, images, audio and video files.  

• insert and delete a slide.  

• view a slide show.  

1.1.Libre Office -Introduction  

LibreOffice is a powerful and free office suite, used by millions of people 

around the world. LibreOffice is a successor to OpenOffice.org (commonly 

known as OpenOffice), which in turn was based on Star Office. Its clean 

interface and feature-rich tools help you unleash your creativity and enhance 

your productivity. LibreOffice includes several applications that make it the 

most versatile Free and Open Source office suite on the market: Writer (word 

processing), Calc (spreadsheets), Impress (presentations), Draw (vector 

graphics and flowcharts), Base (databases), and Math (formula editing). 

LibreOffice is compatible with a wide range of document formats such as 

Microsoft® Word (.doc, .docx), Excel (.xls, .xlsx), PowerPoint (.ppt, .pptx) and 

Publisher. But LibreOffice goes much further with its native support for a 

modern and open standard, the Open Document Format (ODF). With 

LibreOffice, you have maximum control over your data and content – and you 

can export your work in many different formats including PDF. 

1.1.1.LibreOffice-Definition 

LibreOffice is a free and open-source office suite (Program) and a project of 

The Document Foundation. It was forked from Open Office.org in 2010, which 

was an open-sourced version of the earlier Star Office. The LibreOffice suite 

comprises programs for word processing, the creation and editing of 

spreadsheets, slideshows, diagrams and drawings, working with databases, 

and composing mathematical formulae. It is available in 115 languages. 
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LibreOffice is available for a variety of computing platforms, including 

Microsoft Windows, macOS, and Linux (including a LibreOffice Viewer for 

Android), as well as in the form of an online office suite LibreOffice Online. 

It is the default office suite of most popular Linux distributions. It is the most 

actively developed free and opensource office suite, with approximately 50 

times the development activity of Apache OpenOffice, the other major 

descendant of OpenOffice.org. 

The project was announced and a beta released on 28 September 2010 

Between January 2011 (the first stable release) and October 2011, LibreOffice 

was downloaded approximately 7.5 million times. The project claims 120 

million unique downloading addresses from May 2011 to May 2015, excluding 

Linux distributions, with 55 million of those being from May 2014 to May 

2015. 

1.1.2.Applications of LibreOffice 

LibreOffice is look like Microsoft Office and its application also work as Word, 

Excel, PowerPoint and access programs. LibreOffice Include 6 applications 

which is as per given below: 

1. Writer 

2. Calc 

3. Impress 

4. Draw 

5. Math 

6. Base 

1.2. Introduction to Impress 

Impress is the presentation (slide show) program included in LibreOffice. 

Impress creates presentations in the Open Document Presentation (ODP) 

format, which can be opened by other presentation software or can be 

exported in different presentation formats. Slides can be created that contain 

many different elements, including text, bulleted and numbered lists, tables, 

charts, and a wide range of graphic objects such as clipart, drawings and 

photographs. Impress also includes a spelling checker, a thesaurus, text 

styles, and background styles. This chapter introduces the Impress user 
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interface. The remaining chapters in this user guide explain all the features 

available in Impress that can be used to create more sophisticated slide 

shows. To use Impress for more than very simple presentations, requires some 

knowledge of the slide elements. Slides containing text use styles to determine 

the appearance of that text. Creating drawings in Impress is similar to using 

the Draw program included in LibreOffice. See the Draw Guide for more 

details on how to use the drawing tools. 

LibreOffice Impress is a software that is used to create a presentation with 

text effect, graphics, sound to make it interesting and effective for the 

audience. A colourful presentation containing text, photos, picture, sound 

and animation will amaze the viewers and make them more interested to listen 

to the presentation. Animation is the process of creating movement for an 

object. It is a user-friendly application software. 

LibreOffice Impress is a presentation program resembling Microsoft 

PowerPoint. Presentations can be exported as SWF files, allowing them to be 

viewed on any computer with Adobe Flash Player installed. 

To start LibreOffice Impress, we can follow the steps given below:  

1. Click the Start button.  

2. Click All Programs.  

3. Click LibreOffice Impress  

4. Click LibreOffice Impress option.  

1.2.1. Presentation  

A presentation is a structured delivery of information. It is a systematic 

display of information along with graphics, movies, sound, etc. All these are 

displayed together on the screen. 

1.2.2. Create a Blank Presentation  

To create a Blank presentation, follow the given steps:  

1. Click the LibreOffice Impress  

2. Click the New option from the File menu.  
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3. Click Presentation option from the left pane.  

4. Click Blank Presentation option.  
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1.2.3. Working in a Slide  

You know that a LibreOffice Impress presentation is a combination of many 

slides. You can create additional slides. These slides, when displayed in 

sequence, form a presentation. So, in order to prepare a presentation, we have 

to prepare its slides first. 

When you create a Blank Presentation, a slide appears on the screen with two 

placeholders.  

1. Click inside a placeholder to enter text. The cursor appears.  

2. Type the text. After you finish typing the text, click outside the 

placeholder.  

 

 

1.2.4. Inserting New Slide  

To insert a new slide in a presentation, follow the given steps:  

1. Click the Slide Menu.  

2. Click New Slide from slides menu.  

3. Choose the layout you want. For example, Blank, the new slide is 

inserted. Similarly, you can add many slides in a presentation.  



6 
 

 

 

 

 

1.2.5. Inserting pictures  

To Insert a Picture in a slide, choose insert ->Image or click the Insert image 

icon from the Standard Toolbar. 
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1.2.6. Inserting Text Box 

 

Text box is used to add text anywhere on your slide.  

To add the text, follow the given steps:  

1. Select the slide where you want to add a Text Box.  

2. Click the Insert Menu.  

3. Click Text Box from the Text group.  

4. Drag to draw a textbox where you want to add text.  

5. Type whatever you want using the keyboard and click anywhere 

outside the text box.  
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1.2.7. Insert audio and video files  

You can insert audio video files to a slide to make your presentation more 

interesting. By default, LibreOffice provides audio and video clips that you can 

add to the presentation.  

To insert an audio and video from the gallery, follow these steps.  

1. Open the slide  

2. Click insert menu then click audio/video option. Insert audio/video 

dialog box appears.  

3. Locate and select the audio or video file to insert in the slide.  
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1.2.8. Slide Transition  

Slide transitions are the effects that take place when one slide gives way to 

the next one in the presentation, like Roll down from top or Fly in from left. 

They add dynamic flair to a slideshow, smoothing the transition between 

slides.  

Click view menu and then press slide transition option.  

Now you can select any one of the transitions (or) you can choose Slide 

transition option from the Sidebar setting. 
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1.2.9. Animation  

Slide animations are similar to transitions, but they are applied to individual 

elements in a single slide: title, chart, shape, or individual bullet point.  

Select the slide and the object (text box, image) you want to apply the 

animation effect to. In the Sidebar, select Custom Animation icon to open the 

Custom Animation section. Select the animation effect types from one of the 

tabbed pages on the Custom Animation dialog. 
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1.2.10. Deleting Slide  

To delete a Slide, follow the given steps:  

1. Select the slide you want to delete.  

2. Click the Slide Menu.  

3. Click Delete from the Slides menu. The slide gets deleted.  

 

 

 

1.2.11. Saving a Presentation  

To save a presentation, follow the given steps:  

1. Click the File Menu.  

2. Click the Save option. The Save As dialog box appears.  

3. Type the file name.  

4. Click the Save button.  

 

1.2.12. Viewing a Slide Show  

To have a look at how the actual presentation looks is called viewing a slide 

show.  

To view a slide show, follow the given steps:  

1. Click the Slide Show tab on the Ribbon.  

2. Click From Beginning from the Start Slide Show group.  
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You can also press F5 Key on the Keyboard to start the slide show from the 

first slide.  

You see your slides on full screen. Click your mouse each time to see the next 

slide. 

 

 

 

1.2.13. Closing a presentation  

To close a presentation, follow the given steps:  

1. Click File Menu.  

2. Click Close option from the list.  

If the current file is unsaved, LibreOffice Impress displays a dialog box asking 

you to choose whether or not to save your file.  

Select Yes, if you wish to save the file or No, if you do not wish to save the file. 

You can choose Cancel, to return to your presentation without saving it. 

1.2.14. Opening an Existing Presentation  

To open an existing presentation, follow the given steps:  
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1. Click the File Menu.  

2. Click the Open option. The open dialog box appears.  

3. Select the file to be opened.  

4. Click the Open button.  

 

We can also open your file directly by clicking its name from the Recent 

Documents list. 

1.2.15. Exit LibreOffice Impress  

To Close LibreOffice Impress, follow the given steps:  

1. Click the File Menu.  

2. Click Exit LibreOffice Impress.  

 

Demo slides using by libre impress tool 

 

1.3. Conclusion 

The training module on LibreOffice Impress has provided a comprehensive 

understanding of how to create, edit, and present slides effectively. By 

covering key features such as slide formatting, animations, transitions, 

templates, and multimedia integration, users are now equipped with the 

necessary skills to design professional presentations. 

Through hands-on exercises and practical demonstrations, participants have 

gained confidence in using Impress as a powerful, open-source alternative to 

other presentation software. Mastering these tools will enhance productivity 

and creativity, allowing users to communicate their ideas clearly and 

engagingly. 

To further refine their skills, users are encouraged to explore advanced 

features, practice regularly, and stay updated with the latest developments in 

LibreOffice Impress. 


